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Welcome
Thank you for choosing DATS LA, the cutting-edge loudspeaker analyzer.

DATS LA features a Patented Symmetry Test, an innovative method for measuring loudspeaker non-linearity and 
symmetry across a wide power range. By using a series of excursion offsets, the Symmetry Test evaluates parameters as 
a function of displacement (both inward and outward). This results in high-resolution data that shows how each parameter 
varies with cone position, providing a quick and detailed assessment of a loudspeaker’s high-power performance.
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Congratulations on your purchase of the Dayton Audio DATS LA Loudspeaker Analyzer! DATS LA is a unique loud-
speaker analyzer that uses a new type of test signal that can measure loudspeaker parameters as the cone excur-
sion is stepped in each direction. This new test method is exclusive to DATS LA and is protected by U.S. Patent 
11,272,301 B2. DATS LA is a high-powered outgrowth of the popular DATS V3 loudspeaker test system. While DATS 
V3 is a small-signal test system, DATS LA uses up to 100 Watts of power to measure speaker parameters from a 
whisper up to torturous drive levels over the full range of cone excursion (for most drivers).  

Here are step-by-step instructions to get you going quickly. Later, as you wish to learn more about using DATS LA, 
you can see the User’s Guide under the Help menu. 

1) Download and install the DATS LA software.
Download and install the DATS LA software from: “https://www.daytonaudio.com/product/2090/dats-la-loudspeaker-analyzer”.
Double-click on the file and follow the on-screen instructions to complete the software installation. Don’t launch the
DATS LA application software just yet.

2) Connect the DATS LA hardware unit to the PC and to AC power.
Using the supplied cables connect the unit to a PC with the USB cable and then connect to a 120VAC power outlet us-
ing the line cord. The blue “USB” LED at the DATS LA front panel lights up to indicate that a PC is connected. Switch
on the power and look for the green “Power” LED at the front panel.

3) Launch the DATS LA application software.
From the Windows “Start” button select “All Programs” then select “DATS LA”. The DATS LA software will launch.
Accept the license agreement (first time only) and proceed.

4) Calibrate the System (in the following order)

A) Null Calibration (open lead calibration)
Perform this calibration one time when the software is first installed. Because the system uses a full power
signal it is VERY IMPORTANT disconnect the test leads and make sure no speaker or other equipment are
connected to the DATS LA unit when the Null Calibration is performed. When you are fully prepared, at the
Impedance Analyzer menu select “Null Z Calibration” and follow the on-screen instructions.

B) Impedance Calibration at 100 Ohms.
Connect the test leads to the calibration terminals at the DATS LA front panel. Select “Impedance Calibration…”
under the “Impedance Analyzer” menu and follow the instructions to calibrate the system at 100 Ohms using
the built-in ±0.1% calibration resistor. A value between 99.5 and 100.5 Ohms is normally expected.

C) Shorted Leads Calibration
From the DATS LA “Impedance Analyzer” menu select “Test Leads Calibration…”. Short the test leads by clip-
ping them together and click OK to calibrate the software for the test lead resistance. The test lead resistance
should be less than 1 Ohm as seen at the bottom right of the typical DATS screen shown in Figure 1. If the test
leads fail to calibrate select “Impedance Calibration…” under the Impedance Analyzer menu click on “Restore
Default Calibration” and repeat the Null Calibration and test leads calibration procedures.

5) Test a Speaker…connect the DATS LA alligator clips to the terminals of a speaker.
The speaker MUST NOT BE CONNECTED to anything else such as an amplifier, other electrical equipment or
ground. For best results clamp the driver in place and allow adequate clearance for any rear pole piece vents.

6) Click on the “Measure Free Air Parameters” button at the left of the DATS window.
You should hear the sweep and then see the impedance response plotted on screen similar to Figure 1. The im-
pedance magnitude is shown as a blue plot with the phase response shown in red. Several of the speaker’s free air
parameters are displayed in the Parameters Bar at the right side of the screen. The bar at the left side on the window
is where you set the impedance and frequency limits for the current display.

*** VERY IMPORTANT SAFETY NOTE *** 
NEVER connect the DATS LA test leads to a speaker that is 

connected to any other equipment or to an equipment ground! 
Severe damage could occur to the DATS LA unit or to the other 

equipment. Only connect DATS LA to a disconnected loudspeaker.

DATS LA Quick Start Guide
DATS LA runs under Windows (Vista • 7 • 8 • 10 • 11) 
DATS LA Hardware and Software are Designed and Engineered in the USA
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Figure 1: A Typical DATS LA screen

7) Measure the driver’s VAS. 
Once you have measured the speaker’s free air parameters the “Measure V(as)” button becomes enabled. Select 
one of the two methods to measure the VAS at the upper right side of the DATS screen. The two VAS measurement 
methods are: 
 
    1.) Test Box Method - requires a suitable test box 
    2.) Added Mass Method - requires you to add a known mass 
 
Enter the required data and then press the “Measure V(as)” button to start the measurement procedure. 
 
8) After measuring the speaker you can: 
    • Save the data to one of 20 project memories (Alt+1 saves to Memory 1 for example) 
    • Save a DATS LA project file (file extension “.LAZ”) which includes your test setup and all 20 memories 
    • Export the parameters and impedance data in either “.txt” or “.zma” formats 
    • Overlay plots of various measured impedances from the 20 memories for detailed comparison 
    • Print a report showing the impedance and parameters of the displayed memories 
 
9) Quit DATS LA. 
Quit the DATS application software by using “Ctrl+Q” from the keyboard or by selecting “Exit” under the “File” menu. 
 
10) Future sessions with DATS LA. 
In the future when you want to use DATS LA you only need to connect the DATS LA hardware unit and launch the 
software. The software will retain its calibration and user settings from session to session, but it is still a good idea 
to verify the calibration occasionally using the supplied calibration resistor. For full details on using DATS LA see the 
User’s Guide under the Help menu.
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Introducing DATS LA
Dayton Audio unveils the latest generation of the acclaimed Dayton Audio Test System - DATS LA. Building on its 
prestigious reputation, this new iteration pushes the boundaries of precision and performance in audio testing.

•	 Easily Measure Loudspeaker Impedance Response
•	 Measure Loudspeaker Driver Parameters Quickly
•	 Test Loudspeaker’s Symmetry
•	 Screen Drivers for Rub and Buzz Issues
•	 Measure Capacitors including ESR and DF
•	 Measure Inductors including DCR
•	 Measure Resistors
•	 Measure and Compare 70 V Speaker Lines
•	 Generate Audio Waveforms and Sweeps 
•	 Perform General Audio Impedance Measurements

DATS LA introduces an audio interface unit with integrated calibration reference and front panel calibration 
terminals. The rugged aluminum module, powered by the USB port, comes with a detachable USB cable and 
test leads. The system operates with default Windows settings, requiring no adjustments. To ensure accuracy, 
the internal calibration resistor has a tolerance of ±0.1%, achieving measurement accuracy better than ±0.5% 
in the critical range between 1 Ohm and 1k Ohms.
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DATS LA Workbench 

The DATS LA software, available for download at trueaudio.com/dats-la, runs on Windows and offers an intuitive inter-
face, enabling quick setup. Upon launching, it opens with an Untitled Project file. Users can save up to 20 impedance 
measurements per project and overlay any or all to create custom reports. Personal notes can be included with each 
measurement. Speaker parameter measurement with DATS LA is straightforward. Free air parameters are measured 
first, followed by V(as), which can be measured using one of four methods:

•	 Test Box Method

•	 Added Mass Method

The DATS LA system swiftly measures impedance and extracts loudspeaker parameters or passive component values 
(R, L, and C). It features a unique impedance based Rub and Buzz test. Additionally, DATS LA offers a second test 
mode with a general-purpose signal generator and oscilloscope working together. This powerful audio test set sur-
passes previous generations of woofer testers. When paired with DATS LA hardware, the oscilloscope monitors the 
generator output. With standard audio interfaces, the oscilloscope can switch inputs to other devices, enabling the 
monitoring of arbitrary input signals alongside the DATS LA generator output.

While the primary applications for DATS LA may be measuring driver parameters and testing drivers for rub and buzz 
defects, DATS LA is a general purpose impedance measurement system with a broad range of applications. Following 
are some DATS LA applications but experienced users will find many other uses.

DATS LA Includes: 

•	 Hardware Unit: The DATS LA hardware is not only stylishly rugged with its aluminum chassis, but it also fea-
tures a bridged mode output configuration.

•	 Enhanced Measurement Resolution: DATS LA employs an advanced cubic spline interpolation method 
which improves resolution.

•	 Symmetry Test: As a loudspeaker test system, DATS LA’s unique Symmetry Test uses DC offsets to displace 
the speaker cone while measuring speaker parameters with a brief audio sweep superimposed on the DC 
offset. This test reveals speaker non-linearities in each direction of cone displacement. 

•	 Linearity Test: The Linearity Test procedure performs multiple sweeps to automatically measure speaker pa-
rameters over a range of drive levels. This test reveals the linearity of the free air parameters. Each test result 
is automatically saved to a memory so that the impedance plots can be overlaid and compared in any combi-
nation. Parameters can be compared by printing a report or by using Print Preview. 
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While the primary applications for DATS LA may be measuring driver parameters and testing drivers for rub and buzz 
defects, DATS LA is a general purpose impedance measurement system with a broad range of applications. Following 
are some DATS LA applications but experienced users will find many other uses.

DATS LA allows you to:

•	 Measure Speaker Parameters Quickly and Accurately (FS, QTS, QMS, QES, RE, VAS, etc.)

•	 Perform Rub and Buzz Testing (with Continuous Mode for Production Testing)

•	 Measure Values of Resistors, Capacitors (also ESR and DF) and Inductors (also RE)

•	 Generate Audio Waveforms at Any Frequency or Level up to 20 kHz and +5 dBu

•	 Generate Sine, Square, Triangle, Saw Tooth and Impulse Waveforms

•	 Generate Pink Noise, White Noise and Three Different Log Sweeps

•	 Monitor Generator Output Waveforms on The Dual Channel Oscilloscope

•	 Design and Verify Impedance Compensation Networks

•	 Extract Parameters from Imported Driver Impedance Data

•	 Characterize Complete Loudspeaker Systems (FSC, FB, etc.)

•	 Diagnose Loudspeaker Fault Conditions (open or shorted drivers, cables or components)

•	 Perform General Purpose Impedance Measurements (1Hz to 20k Hz, and 1 Ohm to 10k Ohms)

•	 Measure Real and Imaginary Parts of the Impedance in Addition to Magnitude and Phase

•	 Print Detailed Reports and Print Parameters to Standard Address Labels

 Additional Features of DATS LA:

•	 Straightforward, Easy-to-Use Measurement Software

•	 Save and Load Project Files (Up to 20 Memories Each) and Print Custom Reports

•	 1 Hz - 20,000 Hz Response, Measure any Loudspeaker Driver, Including Tweeters

•	 USB Connection Provides Power from and Data Transfer to the PC

•	 Compact USB Interface Includes USB Cable and Molded Test Leads with Alligator Clips

•	 Measured Data Can Be Printed or Saved to Create a Driver Library

•	  Parameters Can Be Exported to WinSpeakerz and Other Popular Box Design Programs

•	 Measures VAS Using Added Mass, Test Box, Specified SPL or Specified MMD Methods

•	 Easily Switch Between Measurement Units by Double-clicking the Units Field

•	 Manufactured with State-of-the-Art Equipment Using Surface Mount Components

•	 USB (blue), Power (green) and Standby (red) LED Indicators

•	 DC Offset indicator LED (red for + : yellow for -)
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The DATS LA Workbench has a plot area in the center of the window with the Impedance dialog bar at the Left and 
the Parameters dialog bar at the right. Below the plot area is the Notes field where the user can enter information 
regarding a measurement. Notes are saved with each memory and recalling a memory will also recall the notes as-
sociated with that memory. At the top of the main window is the DATS LA Toolbar. The main DATS LA window is fully 
resizable and remembers its size and location between measurement sessions. The test signal level is normally 1.23 
Vrms or +4 dBu.

The cursor seen on the impedance plot above is displayed whenever you click near or below the magnitude plot. The 
cursor displays the name of the memory displayed or “Workbench” along with the frequency, magnitude and phase 
of the data point. Click once above the plot to clear the cursor. Holding down the Control Key causes the cursor to 
be displayed continuously as the mouse is moved in the region below the magnitude plot. The selected data point is 
indicated by a small square on both the magnitude and phase plots.

The DATS LA Rub and Buzz Test: 

DATS LA provides a unique Rub and Buzz test based on differential impedance measurements. This impedance 
based rub and buzz test allows rapid screening of drivers for rub and buzz defects without having to isolate the driver. 
The DATS LA rub and buzz test is appropriate for use in transducer production environments as well as in the design 
and manufacture of complete loudspeaker systems. Each production unit can be tested in just a few seconds with a 
single keystroke from the operator. The test result is displayed in a large PASS/FAIL window which also prompts the 
operator to connect the next unit to be tested. 
See also: Rub and Buzz

Log or Linear Impedance Scales: 

The toolbar (or Impedance Analyzer menu) allows easy switching between linear and logarithmic impedance scales. 
Often it is convenient to view impedance on a log scale because the impedance of a pure capacitor or inductor 
becomes a straight line and any non-linearity is seen at a glance. The log impedance scale has adjustments for both 
upper and lower impedance plot limits ranging from 0.01 to 10k Ohms. The linear impedance scale has an adjustment 
for the upper limit that varies from 1 Ohm to 10k Ohms.

Wright Parameters: 

Loudspeaker parameter measurement includes the Wright parameters which are especially useful for precision sim-
ulation of loudspeaker impedance. These parameters allow for the accurate reproduction of a speaker driver’s high 
frequency inductive impedance using the four measured parameters: KR XR KI and XI. See also: Inductance Modeling 
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About the Symmetry Test
The loudspeaker symmetry test allows the user to mea-
sure the performance of a loudspeaker as the cone is 
stepped forward and backward. By quickly and clearly 
revealing how the parameters change with the cone dis-
placement (both forward and back) DATS LA shows the 
nonlinear behavior of such important parameters as BL 
(the force factor) and Kms (the spring constant). At each 
offset step, the system uses a brief frequency sweep to 
measure the complete set of parameters for the driver ren-
der test. After conducting the specified number of sweeps 
in each direction the software plots the driver’s parameters 
versus cone offset to provide a unique view on the driver’s 
performance. 
 
To begin the Symmetry Test, first make sure you have 
entered the Piston Radius of the driver under test at the 
Parameters Bar at the right side of the screen. Select the 
Vas test method that you will use. Choose among: Test 
Box, Added Mass, Specified SPL or Specified Mmd. If 
you are just getting started or just want a quick look at the 
driver, try the Specified SPL method. For development and 
production testing you may prefer to specify the moving 
mass (Mmd).  
 
Switch to the symmetry mode by selecting either the sym-
metry toolbar button “SYM” or select the first item under 
the Symmetry menu. You’ll see the symmetry toolbar 
appear at the left side of the screen. At the left side of the 
screen Specify the driver’s piston diameter and the Vas 
method you want to use for the test. The specified SPL 
method is a good place to start. Once you’ve entered the 
required information press the test button to begin the test.
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DATS LA Hardware Calibration
Hardware calibration is not normally necessary as the unit has been calibrated at the factory. However if the “DC” LED 
remains illuminated (red or yellow) after the unit has stabilized for more than 5 minutes it is recommended that the 
hardware be calibrated.  
 
Tools required: 
     2mm screwdriver 
     DC Voltmeter (multimeter)

About the DC LED and DC Offset Calibrations: 
 
The DC LED illuminates red or yellow to indicate that the DC offset is above or below the acceptable limits of +/- 150 
mV. The DC LED calibration procedure adjusts those voltage limits and sets the stabilized output voltage as close to 
zero as possible.

DATS LA Hardware Calibration Procedure 
 
1.) With the unit stabilized at least 20 minutes connect a voltmeter to the test lead terminals (red to red and  
 black to black).  
2.) Insert a 2mm screwdriver into the DC TRIM pot and adjust to temporarily set the DC offset (at the voltmeter)  
 to +150 mV. 
3.) Move the screwdriver to the LED CAL pot and turn CLOCKWISE until the LED illuminates YELLOW. 
4.) Adjust the LED CAL control COUNTER-CLOCKWISE until the LED first goes off and then continue slowly until  
 the LED turns RED. Stop there. 
5.) Move your screwdriver back to the DC TRIM control and set the DC offset to zero 0 mV (+/-10 mV). The  
 hardware calibration procedure is complete
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Using the DATS LA Memories
The DATS LA software features 20 user memories for saving your detailed measurements along with other user 
entered information about the driver. Each memory consists of the impedance and phase plots, the test setup 
information (test box volume, added mass, etc.) along with the three pages of parameters, specifications and 
comments that are seen at the Driver Editor window. When you save a DATS LA file (type “.laz”) to your computer this 
project file contains all the measurements in the projects 20 memories as well as the data currently on the Workbench.

Note: The most recently measured impedance plot is said to reside on the DATS LA “Workbench.” This measurement 
is overwritten each time the analyzer is run. The Workbench is also overwritten when a memory is recalled or 
when data is imported. Once you have measured data you want to keep (even temporarily) save it to one of the 
20 memories before proceeding with another measurement. All data in the 20 memories is saved with the DATS 
LA project file. Multiple memories can be overlaid to allow for easy comparison of various measurements. Use the 
memory buttons in the Toolbar to show or hide various memories. After a memory has been recalled it can then be 
saved to a different memory. After a memory is recalled it is available to be exported to a .txt file. 

All commands related to memory operations can be found under the “View” menu. Each command is detailed below. 
Note that each command has a keyboard shortcut that you may find more convenient than the menu command after 
you become familiar with the software.

View Menu: Save to Memory

These commands cause the plot on the Workbench to be saved to the selected Memory along with all the driver 
parameters. 

From the keyboard, use Alt+1, Alt+2 etc. through Alt+0 to save to memories 1 through 10. Use Alt+Shift+1, 2 etc. 
through 0 to save to memories 11 through 20. For example, to save the current response to Memory 5 you would 
press and hold the Alt key and then press the 5 key.

View Menu: Show/Hide Memory

These commands alternately show and hide the selected memory:

•	 From the keyboard, use Ctrl+1, Ctrl+2 etc. through Ctrl+0 to show or hide memories 1 through 10

•	 Use Ctrl+Shift+1, 2 etc. through Ctrl+Shift+0 to show or hide memories 11 through 20

For example, to toggle the display of the response in Memory 5 you would press and hold the Ctrl key and then 
press the 5 key. Use Ctrl+W to toggle the display of the Workbench response. In addition to the menu and keyboard 
commands, you can also toggle each memory on or off at the Toolbar as displayed below.
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View Menu: Clear Memory

These commands erase the contents of the specified memory.

•	 From the keyboard, use Ctrl+Alt+1, Ctrl+Alt+2 etc. through Ctrl+Alt+0 to clear the contents of memories 1 
through 10 

•	 Use Ctrl+Alt+Shift+1, 2 etc. through Ctrl+Alt+Shift+0 to clear the contents of memories 11 through 20

For example, to erase the response in Memory 5 you would press and hold the Ctrl and Alt keys and then press the 5 
key. Should you need to clear all of the memories it is usually easier to just create a new project file by selecting “New” 
under the “File” menu.

View Menu: Hide All Memories (Ctrl+E)

This command turns off the display of all memories without affecting the contents of the memories.

Below are sample screen shots of the three Driver Editor pages. While the DATS LA system measures many of the 
parameters detailed on the second page, the remainder of the data, such as the driver’s manufacturer and model 
number, may be entered by the user to create a more complete record on the driver under test. You can add any notes 
you wish at the Description and Comments field on the General Information page of the editor and your notes will be 
saved when you save the Workbench to a memory. When you recall a memory to the Workbench your notes will be 
displayed at both the driver editor General Information page and in the Notes field below the plot window. Entering 
a line or two of descriptive information before saving data to one of the 20 memories makes it easy to keep track of 
the multiple measurements that make up each DATS LA project file. If you edit the notes you will need to save the 
memory again in order to save your changes.
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Using DATS LA to Detect Loudspeaker Rub and Buzz Defects
Before starting make sure the DATS LA unit has been calibrated.

Test drivers for rub and buzz defects as follows:

•	 Launch the DATS LA software.

•	 Click the button labeled “Rub and Buzz” at the bottom left of the DATS LA screen. 

•	 The Rub and Buzz Test dialog is displayed:

The rub and buzz test performs an impedance measurement using a lower signal level than normal to reveal imped-
ance anomalies that indicate rubbing as the cone moves from its rest position. The rub and buzz test provides a user 
adjustable test level which is normally 20, 30 or 40 dB below the normal DATS LA sweep level (approximately +4 
dBu). The lower the level of the test signal the more sensitive the test is to rubbing defects. Guidelines are provided 
for each tolerance setting with the default values being the normal recommendations.

Setting the Test Signal Level

Set the signal lower (larger negative number) to increase the sensitivity of the test and reject more units. Set the signal 
higher (smaller negative number) to decrease the sensitivity of the test and pass more units. A test signal level of -40 
dB causes more units to be rejected than a setting of -20 dB. The recommended setting for beginning testing is -30 
dB. The lowest recommended signal level setting is -40 dB. While the rub and buzz test is not particularly sensitive to 
noise in the test area it is somewhat sensitive to structure borne noise and vibrations. So, it is a good idea to isolate 
the unit under test from the test bench by placing the unit on a small pad (bubble wrap packaging works well) before 
it is tested. An adequately isolated unit will give consistent results when tested repeatedly. A unit picking up structure 
borne vibrations may vary significantly between repeated tests. While -40 is the lowest level recommended for produc-
tion testing the software allows for levels as low as -50 dB for experimentation.

Setting the Resonance Tolerance

Set the resonance tolerance lower (smaller number) to increase the sensitivity of the test and reject more units. To 
reject fewer units set the F(s) tolerance to a larger value. The recommended setting of 40% allows a wide variation so 
that false failures will be a minimum while defective units will be rejected. 
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Setting the Z(max) Tolerance

Set the Z(max) tolerance lower (smaller number) to increase the sensitivity of the test and reject more units. To reject 
fewer units set the Z(max) tolerance to a larger value. The recommended setting of 100% allows a wide variation so 
that false failures will be a minimum while defective units will still be rejected. 

Note that the percentage calculations for both F(s) and Z(max) are a bit different than usual. On the + side the per-
centage deviation is calculated as usual. However, on the negative side the percentage is calculated as a “geometric” 
percentage. That is, a tolerance of (for example) 100% is interpreted as a factor of 2 increase or decrease. So for a 
tolerance setting of 100 % the limits on a 50 Hz resonance become 100 Hz and 25 Hz rather than the 100 Hz and 0 
Hz limits you would get with the usual arithmetic average calculation. This keeps the negative test limits meaningful 
and prevents them from ever reaching zero. With respect to the F(s) a tolerance of 100% now means plus or minus 
one octave and is a much more useful as a test limit. 

The Test Cycle

The rub and buzz test begins with an initialization step where the user is asked to provide a known good sample (ref-
erence sample) that is swept at the normal signal level. This reference measurement is automatically saved to mem-
ory 1 and the user is prompted to connect the first driver to be tested. Each unit under test is tested at the reduced 
signal level specified in the setup dialog and the measurement result is stored in memory 2.

If the “Continuous production Testing” box is checked (the default setting) then after the test result is displayed the 
operator will be prompted to connect the next unit under test. The test cycle consists of the following steps:

1. Press the button labeled: “Initialize and Begin Testing”. The connection dialog shown below appears. 
This dialog can be skipped if desired by checking the box “Skip Rub and Buzz Connection Dialog”.

2. Connect a reference (known good) driver and click “OK” (or press ENTER at the keyboard). The refer-
ence unit is measured and its impedance is stored in memory 1. The dialog below appears.

3. Connect the first unit to be tested and click “OK” (or press ENTER at the keyboard). The unit is test-
ed and its impedance is stored in memory location 2. Either the PASS or the FAIL dialog will appear to 
indicate the test result as shown below.
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4. Connect the next unit under test and press “OK” to test the unit. For each unit tested the operator 
only needs to connect the unit and press ENTER (or click OK). The test procedure “loop” can be inter-
rupted at any time by clicking the “Cancel” button. Resume testing using the current reference imped-
ance by opening the Rub and Buzz setup dialog and clicking the “Resume Testing” button.

In addition to indicating the pass/fail status the pass/fail dialogs also show the per cent deviation from the reference 
unit for the unit just tested. This information can be quite helpful for production technicians when fine tuning the thresh-
olds to be used to reject test units. 

Below is a screen shot showing both the reference and test impedance plots for a unit that passes the (-40 dB) test. 
The low level impedance of the test unit is a good match to the response of the reference unit at full level and the 
driver easily passes.
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Below we see the test results for a unit that has failed the rub and buzz test:

In this case the speaker has failed both parts of the rub and buzz test. The F(s) is in error by 62% with a tolerance 
setting of 40% so it fails the F(s) test. The Z(max) is in error by156% which exceeds the 100% tolerance setting for Z(-
max) causing the driver to also fail this second aspect of the rub and buzz test. The purple plots in each of the last two 
screens are the low level test plots which are compared to the reference green plots. The noise on the purple plots is 
an indication that the signal level is low (not so far above the noise). The green curve (made at full signal level) is quite 
smooth and noise free by comparison. The shifted and miss-shaped resonance of the failed test unit is indicative of 
rubbing and was easily detected by the software. Good units and rubbing units are readily distinguished by comparing 
the F(s) and Z(max) of the test unit to that of a known good reference unit. 

See also: Rub and Buzz Test
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Using DATS LA to Measure a Woofer’s Parameters
Before starting be sure the unit has been calibrated. The basic steps to measure a driver’s parameters are as follows. 

•	 This assumes that the sound system has been setup for DATS LA as described in the Quick Start. 

•	 Start by connecting the DATS LA hardware unit to a USB port on your PC. 

•	 Next, launch the DATS LA software. 

•	 Make sure that the woofer is not connected to any other equipment and then connect the test leads of the 
DATS LA unit to the terminals of the speaker under test. 

•	 Click the “Measure Free Air Parameters” button at the left side of the DATS LA screen. 

•	 You should hear the sweep from the speaker: the impedance is plotted and the parameters are displayed.

•	 Select a method to measure V(as), enter the required data and click on the “Measure V(as)” button.

Here is a typical measurement result:
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After measuring a speaker you may want to enter additional information (the manufacturer and model of the speaker 
for example) at the Driver Editor. Then save the measurement to an empty memory. As an example, the keyboard 
sequence “Alt + 1” saves new data to memory 1. Under the Edit menu select “Open the Driver Editor...” and the Driver 
Editor dialog opens as seen below:

The notes you entered for the measurement also appear at the editor where you can enter additional information on 
the driver which will be saved with that memory. After entering make and model information and switching to the Pa-
rameters tab we see the following page of data with all the measured parameters already entered:

Note that several of the parameters are only seen here at the Driver Editor and are not displayed back at the main 
window. The parameters not displayed at the main window include: C(ms), Z(max), Z(min), S(D), n(0) and BL. 
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DATS LA Troubleshooting
Normally the software automatically detects the hardware, uses the default settings and no adjustments are 
necessary. However, if there is a problem, these are the settings you should check first.

1. Make sure the correct hardware device is selected.
Look under the Edit menu and open the Audio Device Selection dialog. Make sure that “USB AUDIO CODEC” is se-
lected for both input and output as shown below.

2. Examine the USB port settings to verify 2-channel input at 44.1 kHz. Verify the input level. 
From the Windows “Start” button select Control Panel/Sound. Once the Sound Control Panel opens select the “Re-
cording” tab as seen below.



DATS LA 20 DAYTONAUDIO

Next, double-click on the Line device “USB AUDIO CODEC” to open the Properties window seen below.

Switch to the “Advanced” tab and select “2 channel, 16 bit, 44100 Hz (CD Quality)” as seen below.  
 
Now click Apply.
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Next, select the “Levels” tab set the level is set to maximum as seen below and that it is not muted. DATS LA will not 
operate correctly with 1 channel input or at sampling frequencies other than 44.1 kHz.

Click the “OK” button once to close the Properties window and then click “OK” again to close the Sound Control Panel.  

3) Raise the Windows volume control to maximum.
From the task bar, raise the Windows volume control to maximum.

The DATS LA Setup Chart: 
The chart below shows a summary of the Windows Sound Control Panel settings for DATS LA.
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The DATS LA Toolbar
The DATS LA Toolbar provides easy access for many frequently used commands. Memory show and hide operations 
are especially convenient with the toolbar. Note that empty memories are grayed out until data is saved to them. Once 
populated with data, they become enabled, allowing you to switch between show and hide modes.
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Symmetry Menu
Symmetry Test Mode: 

This command switches the application to the  
Symmetry Test Mode

The Symmetry plot commands below select the  
parameter to be plotted.

BL vs. Excursion 

C(ms) vs. Excursion

K(ms) vs. Excursion

F(s) vs. Excursion

L(e) vs. Excursion (1k Hz)

Q(ts) vs. Excursion

Q(es) vs. Excursion

Q(ms) vs. Excursion

Vas (liters) vs. Excursion

SPL (1W/1m) vs. Excursion
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Signal Generator Dialog Bar
When DATS LA is in Oscilloscope Mode, the signal generator dialog bar appears on the left side of the screen. While 
some generator functions are accessible through the Generator menu, the generator is typically controlled from the 
generator dialog bar, as shown below.

At the top of the dialog bar is the On/Off button that starts and stops the generator output. Below the On/Off switch is 
the Frequency field where you enter the frequency for the sine wave generator. The generator can produce fractional 
frequencies such as 20.5 Hz which is very useful in low frequency testing where integer (whole number) frequencies 
are too coarse. The up/down buttons allow you to step the sine wave frequency up or down in steps of various sizes. 
Normally the frequency is stepped in musical half tones or 1/12th octave steps. If the Shift key is held down while step-
ping then the step size is increased to one octave. If the Ctrl key is held down then the step size is reduced to 1 Hz. 
You can also use the keyboard up/down cursor control arrows to step the up/down buttons.

Below the Frequency field is the Amplitude field where you enter the desired signal level in dBu. Note that 0 dBu is 
0.7746 Vrms. The up/down buttons allow the amplitude to be stepped up or down in steps of various sizes. Normally 
the amplitude is stepped in 1 dB increments. If the shift key is depressed the step size is increased to 10 dB. When 
the Ctrl key is held down the step size is reduced to 0.1 dB.

Push buttons below the Amplitude field allow for the selection of sine, square, triangle, saw tooth, or impulse wave-
forms along with pink noise white noise or three different digitally synthesized logarithmic sine wave sweeps. The sine 
wave sweeps automatically repeat.

The Z Sweep Amplitude control sets the sweep level for measuring driver parameters and performing non-specific 
impedance sweeps. The default level is the maximum level of +4 dBu (1.228 Vrms or 1.736 Volts peak). The control is 
restricted to the range from -10 to +4 dBu in order to assure high quality parameter measurement. You should perform 
your routine parameter measurements at the maximum level of +4 dBu. This setting is ignored for all calibrations, rub 
and buzz testing and when measuring resistors, capacitors and inductors. Note that the Windows master volume con-
trol is expected to be at maximum when using DATS LA.

Also see the corresponding Signal Generator menu commands.
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Oscilloscope Overview
The DATS LA oscilloscope shows you the input audio 
waveform with amplitude on the vertical scale versus time 
on the horizontal scale. 

The dual-trace oscilloscope displays the input signals in 
several different modes. The input modes include:

L Left Channel - This is the DATS LA  
 Measurement Channel 
R Right Channel - This is the DATS LA  
 Reference Channel 
L R Left and Right Channels (dual trace)

The voltage range can be adjusted from 5 V per division 
down to 0.001 V per Division. The time base ranges from 
200 ms/Division down to 0.05 ms/Div. The traces can be 
triggered from either the Left or Right inputs. The trace 
can be frozen at any time by pressing Alt+Space. Oscillo-
scope controls are available at both the scope menu and at the detachable dialog bar. The input to the oscilloscope is 
selected at the main Toolbar. The background and trace colors for the scope display can be switched among 5 differ-
ent color schemes at the View menu. The user’s notes are saved along with the trace currently on the workbench with 
each project file.

The Left input channel of the oscilloscope monitors the signal present at the test leads while the Right channel mon-
itors the internal reference signal. It is normal for the two channels to show different results unless the test leads are 
“open” (not connected), then the two sweeps will be identical. For example, the screen below shows the result of 
switching to the oscilloscope mode following a driver parameter measurement. The left (blue) channel shows the fre-
quency sweep revealing the characteristic impedance of the driver while the right (red) channel shows the reference 
sweep unaffected by the unit under test.

The generator and oscilloscope portion of DATS LA can also be used with other PC sound systems besides the DATS 
LA hardware unit to provide separate generator outputs and oscilloscope inputs. When used with the DATS LA hard-
ware the oscilloscope primarily serves to monitor the generator output.

Also see the Oscilloscope menu and Oscilloscope dialog bar for more information.
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Oscilloscope Menu
DATS LA’s oscilloscope allows you to view the generator 
output signal waveform. You can also freeze and print the 
oscilloscope display at any time. Turning the generator on 
and off also starts and stops the oscilloscope. The com-
mands under the Oscilloscope menu are as follows: 
 
Oscilloscope Mode 
 
This command switches DATS LA to the oscilloscope 
mode from the impedance analyzer mode. You can also 
use the leftmost two toolbar buttons to switch between the 
two modes of operation.  
 
Time per Division 
 
Use this popup menu to set the oscilloscope’s time base. 
Alternately you can also set the time base from the oscillo-
scope dialog bar. 
 
Volts per Division 
 
Use this popup menu to set the oscilloscope’s input voltage display range. Alternately you can set the voltage from the 
oscilloscope dialog bar. 
 
Trigger Source 
 
These two commands allow you to select between the left and right channels as the source for oscilloscope sweep 
triggering. 
 
Display Time and Volt Scales 
 
The selected time and volt scales are normally displayed at the bottom of the oscilloscope screen. This command 
allows you to switch the scale display off and on as desired.

Also see the Oscilloscope dialog bar and Oscilloscope overview.
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Oscilloscope Dialog Bar
When you switch from Spectrum Analyzer mode to Oscilloscope mode, the dialog bar on the right side of the screen 
changes accordingly. The Spectrum Analyzer dialog bar is replaced by the Oscilloscope dialog bar, as shown below. 
Similar to the Spectrum Analyzer bar, the Oscilloscope dialog bar replicates the commands found under the corre-
sponding menu.

At the top left of the bar is a vertical group of buttons labeled V/Div for selecting the scope’s voltage sensitivity from 5 
Volt per division down to .001 Volts per division. Another vertical group of buttons labeled ms/Div sets the time base of 
the scope in the range between 200 ms/Div and .05 ms/Div.

At the bottom is the trigger control group. A pair of buttons allow selection of either the left and right inputs for use as 
the scope’s trigger signal. There is also a trigger level setting and an automatic triggering check box to switch the auto 
trigger on or off.

Note that the trace can be started or stopped at any time by pressing Alt+Space. Controls are available at both the 
scope menu and at the detachable dialog bar. At high frequencies, the sound card’s sampling rate limits performance 
and the waveform begins looking course due to individual samples becoming distinctly visible. When viewing high 
frequency signals where the individual data points are sparse it may be helpful to switch off the line mode at the 
oscilloscope section of the Preferences dialog. After the oscilloscope has been stopped you can scroll the available 
waveform data using Alt+Left and Alt+Right. It is also possible to change the trigger setting after the scope is stopped 
and the trace will be retriggered at the new trigger level.

Also see the Oscilloscope menu and Oscilloscope overview for more information.
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Linearity Test
The DATS LA Linearity Test is a fully automated proce-
dure designed to measure speaker parameters across 
various drive levels through multiple sweeps. This test is 
crucial for revealing the linearity of the free air parame-
ters of a speaker. Each test result is automatically saved, 
allowing impedance plots to be overlaid and compared 
in any combination. Users can compare parameters by 
printing a report or using the Print Preview feature.
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Impedance Analyzer Menu
The Impedance Analyzer Menu contains commands for 
running measurements and for performing calibration of 
the test lead resistance and master calibration as follows:

Impedance Analyzer Mode
This command switches DATS LA to the impedance mode 
for measuring driver parameters. A check mark appears 
when in Impedance Mode. 

Plot Impedance on a Logarithmic Scale
This command switches the impedance plot between 
linear and logarithmic scales. Note that on a log scale 
capacitor and inductor impedances plot as straight lines 
allowing any nonlinearities to be easily seen. DATS LA 
will remember the user’s linear/logarithmic plot setting but 
uses the log scale by default.

Also Plot Imaginary and Real Parts

This command causes DATS LA to plot the real and 
imaginary parts of the impedance response in addition to 
the usual magnitude and phase responses. The measured 
impedance response is a complex function which can be 
represented in more than one way. Engineers traditionally 
view impedance responses in terms of magnitude and phase information. Mathematicians might prefer to view that 
same function in terms of its real and imaginary parts. The displayed magnitude and phase are exactly equivalent to 
the real and imaginary data. These are just two different ways to view the same complex impedance response. The 
real and imaginary parts can be calculated from the magnitude and phase as follows:

RE = Magnitude * COS (Phase) 
IM = Magnitude * SIN (Phase)

The real (RE) part of the response is the purely resistive part of the impedance whereas the imaginary (IM) part is the 
reactive part of the impedance representing capacitive reactance when negative or inductive reactance when the imagi-
nary part is positive. The real part is plotted just like the magnitude response with its value being in Ohms and zero Ohms 
at the bottom of the screen. The imaginary response is also expressed in Ohms but is subject be negative. In order to 
keep the imaginary plot on the screen, we plot the absolute value. The real part is plotted in green with the imaginary 
part shown in purple. The real and imaginary parts are only displayed for the impedance response that is currently on the 
Workbench. Responses in memory that are displayed will show only their magnitude and phase responses. To examine 
the real and imaginary parts of a response stored in memory you just need to recall the memory to the Workbench. You 
can also control the display of the real and imaginary parts from the corresponding button on the toolbar.

Measure Free Air Parameters

This command causes DATS LA to run an impedance sweep and then extract the driver’s free air parameters. You 
can also use this command to measure resistor and inductor values. Measuring a resistor should result in a flat im-
pedance plot indicating the resistance is the same across the audio frequency band. R(e) is the measured resistance 
value. The measured resistance can also be read directly from the plot. When measuring an inductor, the plot will rise 
at high frequencies and L(e) indicates the measured inductance value. You can also execute the Free Air Parameters 
command by clicking the same named button at the Impedance Bar at the left side of the main window.

Measure V(as) by the Selected Method

Before any measurements are made this command is disabled (grayed out). After making a free air measurement this 
command becomes enabled and can be used to measure the V(as) of a driver by any of four methods. The V(as) test 
method is selected at the Parameters Bar at the right side of the main window. You can also Measure V(as) by clicking 
the same named button at the Impedance Bar at the left side of the main window. The four methods are: Test Box, 
Added Mass Specified SPL and Specified M(md).

•	 Test Box: This method is probably the most widely used and trusted. For this method you will need a test 
speaker enclosure of suitable size for the driver being tested
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•	 Added Mass: Although the added mass method can employ added mass in the simple form of coins added to 
the cone it is best to make sure the added mass actually adheres to the cone so that it moves with the cone at 
all times. If the mass “decouples” as the cone moves then accuracy will be compromised. Use an added mass 
that will shift the F(s) lower by about 25-50%. An added mass equal to the driver’s Mms is just about right. 
DATS LA will warn you if the shift in the measured F(s) is not within the above recommended range.

Items commonly used for added mass include: coins, modeling clay, carpenters’ putty, rope caulk and tape rolls. In 
general, you should measure the weight of the added mass accurate to 1/10th of a gram. In a pinch, US coins can 
provide an easy source of standard weights. One US nickel ($.05) weighs 5.0 grams.

•	 Specified SPL:  This is a simple V(as) method as it requires no test box or added masses. It is also probably 
the least accurate as it depends strongly on the accuracy of the SPL you specify.

•	 Specified M(md):  This is another simple V(as) method. It requires that you know the actual moving mass of 
the driver. This method is especially suitable for use by driver manufacturers where the driver›s components 
are readily available for weighing. It is also a good method for comparing similar drivers.

Each of the four methods of measuring V(as) requires that you enter the Piston Diameter of the driver. The piston di-
ameter is the effective diameter of the acoustic piston formed by the speaker. The piston diameter is measured as the 
diameter of the speaker cone and normally includes about half of the surround on each side of the cone. For example, 
a nominal 8 inch woofer would probably have an actual piston diameter in the range from about 6.25 to 6.5 inches.

The DATS LA Linearity Test 

Use this command to open the DATS LA Linearity Test dialog shown below. Driver parameters will be cleared to 
prevent any confusion. The DATS LA Linearity Test compares the measured parameters at various signal levels that 
you control. You can set the highest signal level, the total number of sweeps to be performed and the dB step between 
sweeps. The default settings use +10 dBu as the highest-level sweep and provides 3 sweeps at 10 dB steps. This 
provides a good first look at a driver but if you want to see 10 sweeps at 2 dB steps the parameters are easily edited.
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You can accept the default settings and run the test using 3 sweeps (about 10 sec) or customize the number of 
sweeps, the dB step size between sweeps, the maximum signal level and whether the sweeps increase in level or de-
creases in level. Press the “Test” button to run the test. Note that a large number of sweeps will increase the total test 
time. Results are displayed after the last sweep completes. You can then compare sweeps by deselecting the Work-
bench display (the “Mem W” button on the toolbar) and then switching the memories on and off to compare responses 
and parameters. A printed report will contain the plots along with notes for each displayed sweep and provides a good 
way to compare the sweeps. Print Preview also works well for comparing sweeps without printing. 

Impedance Sweep 

Use this command to perform a simple impedance sweep without the extraction of any parameters. Driver parameters 
will be cleared to prevent any confusion.

Rub and Buzz Test...

Use this command to display the Rub and Buzz test setup dialog shown below.

The rub and buzz test performs an impedance measurement using a lower signal level than normal to reveal imped-
ance anomalies that indicate rubbing as the cone moves from its rest position. The rub and buzz test provides a user 
adjustable test level which is normally 20, 30 or 40 dB below the normal DATS LA sweep level. The lower the level of 
the test signal the more sensitive the test is to rubbing defects. Guidelines are provided for each adjustment and the 
default values are the normal recommendations as you start using the test. 

The rub and buzz test begins with an initialization step where the user is asked to provide a known good sample (ref-
erence sample) that is swept at the normal signal level. This reference measurement is automatically saved to mem-
ory 1 and the user is prompted to connect the first driver to be tested. Each unit under test is tested at the reduced 
signal level specified in the setup dialog and the measurement result is always stored in memory 2.

If the “Continuous production Testing” box is checked (the default setting) then after the test result is displayed the 
operator will be prompted to connect the next unit under test. 

Note that you can use the rub and buzz test to screen or match drivers just for F(s) variations by setting the test level 
at 0 dB and setting the Z(max) tolerance to a high value such as 500 %. Then you could set the F(s) tolerance to se-
lect exactly that range of variation you wish to select.

For details on the test procedure see the following application topic: Using DATS LA  to Detect Loudspeaker Rub and 
Buzz Defects



DATS LA 32 DAYTONAUDIO

R: Measure a Resistor...

Use this command to measure a resistor’s value. The first dialog appears prompting the user to connect the resistor 
and click OK. The resistor is measured and the dialog displays the measured value and indicates that the measure-
ment is complete. Driver parameters are cleared to prevent any confusion. Resistors are always measured at the 
maximum signal level (+4 dBu) regardless of the Sweep Amplitude setting.

L: Measure an Inductor...

Use this command to measure the value of an inductor along with its DC resistance. The first dialog appears prompt-
ing the user to connect the inductor and click OK. The inductor is measured and the dialog displays the measured 
inductance and DC resistance and indicates that the measurement is complete. Inductors are always measured at the 
maximum signal level (+4 dBu) regardless of the Sweep Amplitude setting.

The software controlled test extracts the inductance at numerous frequencies and then uses only those values in the 
range where impedance measurement is most accurate to calculate an average value of inductance. Driver parame-
ters are cleared to prevent any confusion. This test is very accurate on inductors but is not recommended for measur-
ing speaker inductance, L(e) due to the resonance peak. To measure a speaker’s voice coil inductance, L(e), use the 
“Measure Free-Air Parameters” command. 
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C: Measure a Capacitor...

Use this command to measure the value of a capacitor. The first dialog appears prompting the user to connect the 
capacitor and click OK. The capacitor is measured and the dialog displays the measured value and indicates that the 
measurement is complete.  The software controlled test extracts the capacitance at numerous frequencies and then 
uses only those values in the range where impedance measurement is most accurate to calculate an average value 
of capacitance. Driver parameters will be cleared to prevent any confusion. Capacitors are always measured at the 
maximum signal level (+4 dBu) regardless of the Sweep Amplitude setting.

In addition to measuring the capacitance of a device, DATS LA also measures the equivalent series resistance (ESR), 
dissipation factor (DF), quality factor (Q) and loss angle (delta). These additional capacitor parameters are useful for 
those designing power supplies and power amplifiers as well as speaker designers building passive crossovers.
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Impedance Calibration...   

When first installed, DATS LA is accurate to about 10% for the impedance range under 1000 Ohms. Use the imped-
ance calibration procedure to fully calibrate your particular DATS LA hardware unit. When you select this command 
the impedance calibration dialog (shown below) will open. 

Normally you will use the built-in calibration resistor but you can enter a different value for the calibration resistor (if 
different from the recommended 1k Ohms). Connect the test leads to the metal calibration terminals on the front panel 
of the DATS LA unit and click OK. The software will measure the calibration resistor and adjust its calibration data 
accordingly. After calibration is complete another measurement is made to for you to verify the new calibration. Calibration 
will typically be improved to be within 1% following calibration with the DATS LA built-in reference resistor. It is possible to 
calibrate the unit with an external resistor in the range from about 500 to 2k Ohms but this is not generally recommended. 
It is important that the value of the calibration resistor be known to at least within +/- 0.1% of its true value. 

When you exit the application, the new calibration will be remembered for your next session. Impedance calibration 
normally only needs to be performed one time after the software is installed on a PC but for critical measurements you 
may want to calibrate the unit at the beginning of each session or at least measure the value of the calibration resistor 
to verify correct calibration. Calibrations are always measured at the maximum signal level (+10 dBu).

Test Leads Calibration...   

When the software is first installed the default test lead impedance is 0 Ohms. Use this command to perform the test 
lead calibration for your DATS LA unit. When prompted, just short the test leads together and click OK. The software 
will measure the test lead resistance and adjust the internal calibration. When you exit the application the new test 
lead calibration will be remembered for your next session. If the test leads should fail to calibrate then select “Imped-
ance Calibration...” under the Impedance Analyzer menu, click on the “Restore Default Calibration” button and repeat 
the test leads calibration procedure. The test leads calibration sweep is always performed at the maximum signal level 
(+10 dBu) regardless of the Sweep Amplitude setting.
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This topic is excerpted from Introduction to Loudspeaker Design 2nd Edition by John L. Murphy

3.8.4 Speaker Parameters and Signal Level

There seems to be a bit of confusion in DIY speaker circles about what signal level is appropriate for measuring 
small-signal parameters, so let’s look at this question more closely. In his groundbreaking paper titled “Loudspeakers 
in Vented Boxes,” Neville Thiele1 discusses the test signal level for measuring parameters and states:

“The value is not of great importance, but a standard test fi gure is 1 volt.”

In his excellent book titled “Testing Loudspeakers,” Joe D’Appolito XE “D’Appolito” 16 writes: 

“The T/S parameters are “small signal” parameters. It is important …to keep drive levels as low as your in-
strumentation will allow while still providing reliable results.”

So the test signal level is not very important as long as the measurement is not contaminated with noise and is well 
below the large-signal threshold.

The objection is sometimes heard that fS can change with drive level, so it would seem that the parameters should be 
measured at higher power levels. It is easy to demonstrate—in the case of well-designed transducers that are operating 
normally (i.e., not damaged)—that the fS of a driver does not change signifi cantly over a very wide range of operation. 

In fact, a shifting in fS at high drive levels would indicate the onset of nonlinearity and would not constitute a val-
id small-signal measurement. At the other extreme, a shift in fS at low drive levels is an indication that a driver has 
mechanical obstructions such as debris in the magnetic gap. This behavior is the basis for the rub and buzz test I 
developed for the Dayton Audio Test System (DATS). For example, Figure 3.12 shows the impedance of a transducer 
measured at eight different drive levels over a 70 dB range in 10 dB steps. At the lowest drive levels, the resonance 
vanishes into the noise but the shape (Q) and center frequency (fS) remain unchanged over the 70 dB range of mea-
surement signal level. This is typical behavior for a well-designed driver.

Figure 3.12:  Impedance responses measured at progressively lower signal levels for a 
properly functioning loudspeaker
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In comparison, Figure 3.13 shows the same test repeated on a different driver with a rubbing voice coil. Here the 
resonance is seen to increase at lower drive level due to the stiction (static friction) caused by the mechanical rubbing 
within the unit.

Figure 3.13:  Impedance responses measured at progressively lower signal levels for a defective loudspeaker

[1] A. N. Thiele, “Loudspeakers in Vented Boxes, Parts I and II,” Proc. IREE (Australia), vol. 22, p. 487 (Aug. 1961). 
Also, J. Audio Engineering Soc., vol. 19, p. 382 (May 1971); p. 471 (June 1971).

[16] D’Appolito, Joseph A., Testing Loudspeakers, Audio Amateur Press, 1998.
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This topic is excerpted from Introduction to Loudspeaker Design 2nd Edition by John L. Murphy

Glossary of Terms

2-way system : A loudspeaker employing two transducers.

3-way system : A loudspeaker employing three transducers.

Acoustic Suspension : A closed box loudspeaker with alpha greater than about 3.

AES : The Audio Engineering Society. Most of the important loudspeaker technology literature to date has been pub-
lished in the Journal of the AES.

Baffle : The surface of the enclosure on which the driver is mounted. For a dipole the baffle completely supports the 
driver and there is no enclosure.

Bandpass Filter : A filter which blocks frequencies above and below some middle band of frequencies.

Bandpass Enclosure : A loudspeaker with a bandpass filter response.

CD : Compact Disc

Capacitor : A basic electrical component usually constructed as a sandwich of foil layers separated by a thin plastic 
film . A capacitor passes high frequencies but impedes low frequencies and completely blocks direct current.

Closed Box : A sealed loudspeaker enclosure which exhibits a 2nd order high-pass response.

Compliance Ratio (alpha, α) : Alpha is the ratio of the compliance of the driver to the compliance of the air in the 
driver’s enclosure. Also the ratio of the driver’s VAS to the enclosure VAB.

 α = VAS/VAB = CMS/CMB

Crossover : An electrical network for dividing a signal into appropriate frequency ranges for different transducers, 
typically a woofer and a tweeter.

dB : A logarithmic unit of change in sound pressure or signal level ratios.

  delta dB = 20 log(V1/V2)  ratio of voltages

 delta dB = 10 log (P1/P2)  ratio of powers 

 3 dB corresponds to a doubling or halving of power.

 6 dB corresponds to a doubling or halving of voltage.

 10 dB corresponds to a factor of 10 in power.

 20 dB corresponds to a factor of 10 in voltage.

 

dB SPL: A dB sound loudness measurement where the reference (0 dB SPL) is the threshold of human hearing and 
120 dB SPL is considered to be the threshold of pain.

dBm: A power measurement system originally used by the phone company with 1 milliwatt as the reference. 

dBu: A voltage measurement system with 0.775 Vrms as the reference. This corresponds to the telephone standard of 
1 milliwatt at 600 Ohms.

Diffraction Loss: A reduction in low frequency output resulting from the reduced low frequency spatial load when 
speaker enclosures are used in free space.

Dipole: A loudspeaker where the rear side of the speaker is not enclosed.

Driver: A loudspeaker transducer.

Efficiency: The ratio of output acoustical energy to input electrical energy usually expressed as a percentage Z

Excursion Response: The peak displacement of the cone plotted versus frequency for a constant drive level.
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Frequency: A rate of repetition expressed in Hertz (Hz).

Frequency Response: The output amplitude of a system plotted versus frequency. For audio systems the amplitude 
is most often expressed in dB or dB SPL.

Golden Ratio: Also known as the golden section or golden mean. This is a preferred ratio for use in designing speak-
er enclosures because it distributes the resonance modes with minimum overlap. The golden ratio is calculated as: 

φ =  = 1.618033989…

Hertz: Cycles per second (after German physicist Heinrich Hertz).

High-pass Filter: An electrical network that passes high frequencies and blocks low frequencies.

Impedance: A complex form of resistance which can vary with frequency. 

Inductor: A basic electrical component usually constructed as a coil of wire. An inductor passes low frequencies but 
impedes high frequencies.

Isobaric Configuration: A speaker system where two drivers are stacked either face to face or back to back and used 
as if they were a single drive unit with half the VAS of a single driver.

 Low-pass Filter: An electrical network that passes low frequencies and blocks high frequencies.

Multi-Way Loudspeaker: A loudspeaker employing multiple transducers.

Octave: A change of a factor of two in frequency, either double or half. A musical span of twelve semi-tones.

Order: The order of a filter is a reference to the highest exponent in the polynomial that describes the filter’s response. 
High and low-pass filters will provide 6dB/octave of ultimate cutoff slope for each order of the filter. A 1st order filter 
has 6 dB/octave cutoff slopes while a 4th order filter has 24 dB/octave slopes. A 4th order bandpass filter might have a 
combined 2nd order high-pass and 2nd order low-pass response.

SPL: Sound pressure level or the loudness of a sound.

Thiele-Small Parameters: The speaker transducer specifications required to design a loudspeaker system.

Total Q: The combination (geometric mean) of the electrical and mechanical Q’s of a speaker.

Transducer: A unit that transforms energy from one form to another. A loudspeaker transducer converts electrical 
energy into acoustic energy.

Tweeter: A high frequency transducer unit.

Watt: 1 Joule of energy per second, the basic unit of power (after Scottish engineer James Watt).

Woofer: A low frequency transducer unit.

Vented Box: A sealed loudspeaker enclosure which employs one or more tubes, a shelf or a simple opening in the 
baffle to convert the enclosure into a Helmholtz resonator with some well-defined resonance frequency, fB. Vented box 
loudspeakers have a 4th order high-pass response.
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This topic is excerpted from Introduction to Loudspeaker Design 2nd Edition by John L. Murphy

Glossary of Symbols

α : The compliance ratio of the loudspeaker system

B : Magnetic flux density in the voice coil gap

c : The speed of sound in air (345 m/sec)

CMS : The compliance of a driver’s suspension

CMB : The compliance of the volume of air in the enclosure

dB : Decibel, one tenth of a Bel (doubling or halving of loudness)

f3 : The -3 dB frequency of a filter

f10 : The -10 dB frequency of a filter

fB : The tuning frequency of a vented enclosure

fS : The free air resonance of a speaker

fSC : The closed box system resonance frequency

λD : Wavelength at dipole cutoff frequency 

η0 : Half space reference efficiency

PE(max) : Thermally limited input power

PER : Mechanically limited input power

Q : The “quality” factor of a resonance

QB : The box loss Q, typically about 7

QTC : The closed box system total Q

QTS : The total Q of a driver (mechanical and electrical)

QMS : The mechanical Q of a driver

QES : The electrical Q of a driver

SD : The driver’s piston area

VAS : The equivalent volume of a driver’s suspension

VAB : The acoustic volume of the enclosure (considering filling)

VB : The volume of the enclosure

VD : Driver displacement volume

WD : Average width of the dipole baffle

XMAX : Linear excursion limit

XMECH : Maximum mechanical excursion limit
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This topic is excerpted from Introduction to Loudspeaker Design 2nd Edition by John L. Murphy

3.8 The Thiele Small Parameters

The so-called Thiele-Small parameters of a loudspeaker are those specifi cations of the loudspeaker driver which 
allow us to predict the frequency response of the driver in various enclosures. The parameters are named after Neville 
Thiele and Dick Small, the Australian loudspeaker researchers who gave birth to modern loudspeaker theory in the 
1960’s and 70’s.

3.8.1 The Small-Signal Parameters

The so-called “small-signal” parameters characterize the resonance of a speaker during normal operation. Like many 
other electronic devices, loudspeakers have an input signal range where they work normally. Beyond that range is 
some threshold above which the speaker exhibits misbehavior such as increasing distortion, reduced output, or even 
catastrophic failure. The signal range where the speaker operates normally is called the “linear region,” versus the 
“non-linear region” where distortion rises rapidly. The small-signal region is that range between the noise fl oor and the 
point where the system is no longer linear. This is the signal range where a loudspeaker’s small-signal parameters are 
measured. Small-signal testing is usually performed at the lowest signal level where there is adequate signal-to-noise 
ratio. See Figure 3.11 for a comparison of small-signal and large-signal ranges of operation. 

Figure 3.11:  Small-signal versus large-signal operating ranges

The small-signal parameters of a loudspeaker are1:

 fS The free air resonance
 QES The electrical Q
 QMS The mechanical Q
 QTS The total Q
 VAS The equivalent volume of the suspension

The Free Air Resonance (fS) is the resonant frequency of the driver when it is placed in free air, meaning it is not 
enclosed. This is the natural frequency of the driver that you hear when you gently tap the cone. Typical woofer res-
onance frequencies might range from 20 Hz to 80 Hz. Midrange drivers would be somewhat higher. A typical 1inch 
dome tweeter also has a resonance frequency, usually in the neighborhood of 1 kHz. The resonance frequency of a 
loudspeaker component is generally about the lowest frequency at which the driver can be used. 

The Total Q, or QTS of the driver is a measure of the sharpness of the driver’s resonance. It depends on both the 
mechanical and electrical characteristics of the driver. Indeed, the QTS is calculated from the electrical Q, QES and the 
mechanical Q, QMS of the driver. The driver’s QTS indicates the shape of the driver’s frequency response curve when 
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placed on an infinite baffle. The higher the QTS the more peaked the response at resonance. The lower the QTS the 
more round the knee of the frequency response curve will be at that low frequency where the response begins to fall 
off. The driver Q’s are “dimensionless” numbers or “pure” numbers and are not expressed in any units.

The Equivalent Volume of the Suspension, VAS, is that volume of air which would be as stiff as the suspension of 
the driver when compressed by a piston the same size as the driver’s cone. The VAS is a volume of air usually ex-
pressed in either cubic feet or liters.

3.8.2 The Large-Signal Parameters

In contrast to the small-signal parameters, the large-signal parameters are intended to characterize the driver’s 
performance limitations near its power limit as it becomes non-linear. Large-signal parameters are usually best left to 
the manufacturer to measure, as they may require disassembly or destructive testing. The large-signal parameters 
include:

 PE(MAX) The thermally limited input power 
 PER  The mechanically limited input power 
 XMAX  The maximum linear excursion 
 XMECH  The maximum mechanical excursion 
 SD  The piston area 
 VD  The maximum displacement volume 
 
The thermally limited input power, PE(MAX), represents the maximum continuous power that can be applied to the 
driver for an extended period before the driver is damaged due to excessive voice coil heating. This is usually the 
power specified by the manufacturer. 

A second power limit of a speaker system is the mechanically limited input power, PER. This power limit is not deter-
mined until the driver is incorporated into an enclosure and depends not only on the details of the enclosure but also 
on the frequency of operation. A system may have plenty of mechanical power handling capability at 200 Hz but be 
severely limited at 30 Hz due to excessive cone excursion. The mechanically limited input power is that power which 
drives the cone to its full excursion limit. Depending on the particular speaker system design the driver’s mechanically 
limited input power might be greater than the thermally limited power over the entire frequency range where the sys-
tem will be used. In that case the overall system power limit will be the driver’s rated thermal power. 

It is not unusual for a system to be limited to less than the driver’s thermally rated power because of increased cone 
excursion at the lowest frequencies. Indeed, it is possible to design a system using a 100-Watt woofer that just reach-
es its excursion limit at 100 Watts at 60 Hz but at 40 Hz reaches its excursion limit at just 20 Watts. We would say that 
this system was “mechanically limited” below 60 Hz and “thermally limited” above 60 Hz. Clearly one single power 
rating is not enough to fully describe a loudspeaker system!

The maximum linear excursion, XMAX, of a driver is a measure of how far the cone can move from rest before the 
voice coil begins to move out of the magnetic gap. Increasing distortion will result if the system is driven beyond XMAX. 
If the driver is pushed far beyond its XMAX there comes a point when the cone will hit its mechanical stops and a loud 
popping sound will be heard as the cone “bottoms out”.  This second excursion limit is sometimes called XMECH or the 
maximum mechanical excursion of the driver. Pressing a driver to its maximum excursion can result in damage to 
the voice coil as the delicate voice coil smacks into the back plate. Depending on the driver, the XMECH could be slightly 
greater than XMAX or there could be a comfortable margin of safety between XMAX and XMECH.

The piston area, SD, of the driver is the effective area of the driver’s cone. This is normally calculated by measuring 
the diameter of the cone from about the middle of the cone’s surround at one side to the center of the surround at the 
opposite side.  The driver’s surround is the foam, rubber or cloth edge that connects the outer edge of the cone to the 
frame of the driver. A typical 12 inch diameter woofer has a piston diameter on the order of 10.5 inches.

Multiplying the piston area by the XMAX gives us the maximum displacement volume, VD of the driver. A driver’s VD 
specification gives an indication of the low frequency output capability of the driver. The larger the VD, the greater the 
driver’s excursion limited low frequency output capability.

3.8.3 Additional Speaker Parameters

Some speaker parameters are not clear members of either the small or large-signal categories and are listed here 
separately. 

 RE The DC resistance of the voice coil 
	 η0 The	half	space	reference	efficiency 
 LE The voice coil inductance 
 BL The force factor 
 ZMAX The maximum impedance
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The DC resistance of the voice coil, RE, is an important parameter as it represents the approximate load the speak-
er will present to an amplifier. RE is typically around 80% of the nominal impedance value. An 8 Ohm speaker would 
have a RE of around 6.4 Ohms according to this rule of thumb.

The half	space	reference	efficiency,	η0, is the ratio of acoustic Watts of output to electrical Watts of input power to 
the driver when it is radiating into a half space acoustic load.

The voice coil inductance, LE, is usually given at 1 kHz but is sometimes given at 10 kHz for smaller drivers or 
tweeters. A speaker’s high frequency impedance is not actually represented well as a simple inductor because ideal 
inductors do not vary with frequency. Improved models of voice coil inductance are represented as combinations of 
resistors and inductors.

The BL product or force factor gives an indication of the magnetic motor strength. B is a measure of the magnetic 
flux density while L is the length of voice coil wire in the magnetic gap. BL is expressed as N/A or Newtons per Amp, 
that is, Newtons of force per Amp of voice coil current.

The maximum impedance, ZMAX, is the maximum impedance at the primary resonance of the speaker and is speci-
fied in Ohms.

Besides the Thiele-Small parameters most driver manufacturers include a wide range of other specifications for their 
products. These usually include parameters such as the magnet weight, voice coil diameter, nominal impedance, SPL 
output for 1 Watt of input at 1 meter and so on. 

Reference:

[1] A. N. Thiele, “Loudspeakers in Vented Boxes, Parts I and II,” Proc. IREE (Australia), vol. 22, p. 487 (Aug. 1961). 
Also, J. Audio Engineering Soc., vol. 19, p. 382 (May 1971); p. 471 (June 1971).
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This topic is excerpted from Introduction to Loudspeaker Design 2nd Edition by John L. Murphy
 

3.6 Impedance Response

The shape of a loudspeaker’s impedance curve reveals much about a speaker. For example, a closed box speaker 
system will have an impedance response with a single resonance peak whereas a vented box will have two peaks in 
its impedance response. See Figures 3.9 and 3.10. 

The shape of the impedance peak implies the QTC value of the system. For a high Q system, say 3 or more, the 
impedance peak will be narrow. A system with a Q of 1 would have a wider, more rounded impedance peak and a 
system with a Q of .5 would have a relatively broad impedance peak.

Figure 3.9:  Frequency and impedance responses of a closed box
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The impedance magnitude response represents “resistance,” so to speak, as a function of frequency. An ideal imped-
ance response would be a flat line at the nominal impedance of the speaker. However, most real-world loudspeakers 
do not have a flat impedance response. Typically, a woofer system will have an impedance peak at the system’s low 
frequency resonance or two peaks in the case of a vented box. At higher frequencies the speaker’s impedance will 
increase due to the effect of voice coil inductance.  

Figure 3.10:  Frequency and impedance responses of a vented box

When the driver is placed in an enclosure the driver’s impedance is changed by the effect of the enclosure. In the case 
of a vented box the impedance peak is actually split into two peaks by the effect of the enclosure. Some advanced 
speaker manufacturers use impedance compensating networks to provide a more neutral impedance response for 
their speakers. This is because crossovers perform better when loaded by drivers with a flat (resistive) impedance 
response. Power amps will operate with the least heat dissipation when driving a resistive (low reactance) load. 



DATS LA 45 DAYTONAUDIO

Generator Menu
The commands under the Generator menu are as follows:

Generator Mode
Switches from the impedance measurement mode to the generator and oscilloscope mode. The generator bar appears 
at the left side of the plot window and the oscilloscope bar appears at the right side of the plot window as seen below. 
You can switch between impedance and generator modes using the two leftmost buttons of the toolbar. You can also 
switch back to the impedance mode by selecting “Impedance Mode” under the Impedance Analyzer menu.

 

The Oscilloscope Workbench
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Generator On/Off
Toggles the Generator On/Off.

Sine Wave
Selecting this menu item sets the generator to produce a sine wave. Unlike the inexpensive signal generators fre-
quently seen on audio test benches this digital signal generator produces a sine wave with very low distortion. Once 
you have performed the Line Output Calibration procedure the level of the output signal will be precisely the level you 
entered (in dBu) at the Amplitude Field of the Generator Bar. Specifying an amplitude of 0.0 dBu will result in a sine 
wave of the specified frequency with amplitude equal to 775 millivolts rms (0 dBu). Ideal sine waves have a modest 
crest factor of 1.414 (3.01 dB).

Square Wave
Sets the generator to produce a low distortion square wave at the specified amplitude. While an ideal square wave 
would have a crest factor of exactly 1 (0 dB). DATS LA’s square waves will typically have higher crest factors around 
1.25 (2 dB) due to low frequency tilt and/or high frequency overshoot.

Triangle Wave
Sets the generator to produce a low distortion triangle wave at the specified amplitude. Triangle waves ideally have a 
crest factor of 1.73 (4.77 dB)

Saw Tooth Wave
Sets the generator to produce a low distortion Saw Tooth wave at the specified amplitude. Saw Tooth waves ideally 
have a crest factor of 1.73 (4.77 dB)

Impulse Wave
Sets the generator to produce a low-distortion impulse wave with an RMS level 10 dB below the specified amplitude. 
This reduced level is necessary because the waveform has a high crest factor and the peaks would be overdriven at 
the usual specified rms level. The impulse waveform is generated with 1 sample per period at full amplitude. At 100 Hz 
the crest factor is about 20 (26 dB) for 44.1 kHz sampling. At 1 kHz the crest factor is about 6 (15.5 dB) for 44.1 kHz 
sampling. 

Pink Noise 
Selecting this menu item sets the generator to produce pink noise at the level specified in the Amplitude Field of the 
Generator Bar. Use the On/Off button on the Generator Bar to start and stop the pink noise output. Pink noise has a 
flat frequency response when the response is averaged using an RTA. Be careful not to set the generator level so high 
that you overdrive the pink noise as this will result in a non-flat response. Pink noise is generated at the specified level 
but note that it has a somewhat high crest factor of about 4 (12 dB). Caution: Pink noise peaks are at risk of being 
clipped for output levels higher than about -6 dBu on many PC sound systems (including the UCA202). Note that over-
driven (clipped) pink noise will appear to have a rising high frequency response.

White Noise
Selecting this menu item sets the generator to produce white noise at the level specified in the Amplitude Field of the 
Generator Bar. Use the On/Off button on the Generator Bar to start and stop the white noise output. White noise has 
a frequency response that rises at a rate of 3 dB/octave when the response is averaged using an RTA. On a FFT ana-
lyzer white noise would appear to have a flat response. DATS LA’s white noise has a crest factor of around 2.8 (9 dB).

 
Sweeps 1, 2 and 3
DATS LA provides three digitally synthesized sweeps of different lengths which repeat automatically. The logarithmic 
sweeps cover fractional frequency intervals in equal time. That is, as much time is spent sweeping the interval from 20 
to 40 Hz as from 10 k to 20 kHz. Compared to linear sweeps, the logarithmic sweep spends as much time in the low 
frequency region as in the highs. The signal level of the sweep is determined by the Generator’s amplitude setting.
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Square Wave Duty Cycle
Select this menu command to open a dialog box where you can set the duty cycle of the square wave. The normal 
value of duty cycle for a square wave is 50%. Note that a perfect 50% duty cycle square wave has no even harmon-
ics. The crest factor of the waveform is increased as the duty cycle is changed from 50% toward either the 100% or 
0% extreme. 

Also see the signal generator dialog bar.
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Minimum Requirements for the PC
To run DATS LA, your PC must meet the following minimum requirements:

•	 Windows VISTA, 7, 8, 10, or 11

•	 One available USB port
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Using DATS LA to Measure a Woofer’s Parameters
Before starting be sure the unit has been calibrated. The basic steps to measure a driver’s parameters are as follows. 

•	 This assumes that the sound system has been setup for DATS LA as described in the Quick Start. 

•	 Start by connecting the DATS LA hardware unit to a USB port on your PC. 

•	 Next, launch the DATS LA software. 

•	 Make sure that the woofer is not connected to any other equipment and then connect the test leads of the 
DATS LA unit to the terminals of the speaker under test. 

•	 Click the “Measure Free Air Parameters” button at the left side of the DATS LA screen. 

•	 You should hear the sweep from the speaker: the impedance is plotted and the parameters are displayed.

•	 Select a method to measure V(as), enter the required data and click on the “Measure V(as)” button.

Here is a typical measurement result:
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After measuring a speaker you may want to enter additional information (the manufacturer and model of the speaker 
for example) at the Driver Editor. Then save the measurement to an empty memory. As an example, the keyboard 
sequence “Alt + 1” saves new data to memory 1. Under the Edit menu select “Open the Driver Editor...” and the Driver 
Editor dialog opens as seen below:

The notes you entered for the measurement also appear at the editor where you can enter additional information on 
the driver which will be saved with that memory. After entering make and model information and switching to the Pa-
rameters tab we see the following page of data with all the measured parameters already entered:

Note that several of the parameters are only seen here at the Driver Editor and are not displayed back at the main 
window. The parameters not displayed at the main window include: C(ms), Z(max), Z(min), S(D), n(0) and BL. 
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Signal Generator Overview
Switch to the Oscilloscope Mode to use the signal generator. The oscilloscope operates whenever the generator is 
running and serves to monitor the generator output when used with the DATS LA hardware. If a general purpose audio 
interface is available then the DATS LA software generator output appears at the line out connections while the line 
input connections provide input to the oscilloscope.

 
The Oscilloscope Workbench 

To evaluate an audio product, such as an equalizer, amplifier, or loudspeaker, you need a stimulus test signal for the 
unit under test and an analyzer to measure the output signal characteristics. The signal generator’s flow is from the 
software to the PC sound system’s line output, which is connected to the input of the unit under test. The output signal 
from the unit under test is then routed back to the PC sound system’s line input and onward to the DATS LA oscillo-
scope.

The DATS LA signal generator produces a low-distortion sine wave adjustable from 5.0 Hz to 20 kHz. The output 
level is specified in dBu. In addition to the sine wave, the generator can also generate square, triangle, saw tooth and 
impulse waveforms as well as pink noise and white noise. The duty cycle of the square wave is adjustable. DATS LA 
also provides three different digitally synthesized logarithmic sine sweeps from 10 Hz to 20 kHz. This digital sweep 
is a high-resolution alternative to using pink noise or stepped sine methods for system testing. You can also use the 
repeating sweep as a quick way to identify particular speaker cables in complex installations.
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Removing DATS LA from your Computer
You can easily remove DATS LA from your computer’s hard drive if needed. 

•	 Go to the control panel and double click on “Programs and Features” (or “Add/Remove Programs”)

•	 When the Add/Remove dialog appears locate DATS LA in the list

•	 Select DATS LA and then click on the Add/Remove button

•	 When you are asked “Are you sure you want to completely remove the selected application and all of its com-
ponents?” select “Yes”

DATS LA will be removed from your computer.
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Linearity Menu

Linearity Test

With the increased output capability, the DATS LA can 
begin to see changes in parameters with drive level. This 
test automatically performs multiple sweeps of the driver 
at increasing (or decreasing) levels while saving each 
test result to memory. After the data is collected, users 
can compare the results by recalling and comparing 
impedance plots and parameters.
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Help Menu
The commands under the Help menu are as follows:

User’s Guide

The complete DATS LA User’s Guide is available under the Help 
menu. The User’s Guide opens at the Contents tab and also 
includes Index and Search tabs for easy navigation.

User Information

Enter your personal information in this window. This information 
will be displayed on the Splash Screen and in the title block of 
your printed reports.

About DATS LA 
Displays the DATS LA version number, copyright and user information.
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File Menu
The commands under the File menu are as follows:

New (Ctrl+N)
Clears all current data to create a new, empty DATS 
LA project file. Each project file can hold up to 20 
measurements in individual memories. You can display 
or hide these memories by clicking the corresponding 
memory buttons on the toolbar.

Open… (Ctrl+O)
Opens a previously saved DATS LA project file (.laz) from 
your computer. You can launch DATS LA and open a 
project file by double-clicking the file icon on your desktop. 
Alternatively, project files can be opened by dragging and 
dropping them onto the open application window.

Save (Ctrl+S)
Saves a DATS LA  project file to disc with the .laz filename 
extension. A single .laz file can contain up to 20 memories 
of data and notes in addition to the immediate data 
and notes on the Workbench. Project files also contain 
complete test setup information so that opening a saved 
project file restores the test setup that was in place when 
the project file was saved. This includes such settings as 
the Impedance and Frequency plot limits. In addition, a 
large number of measurement setup variables are saved 
within each project file.

Save As…
Brings up a save as file dialog which allows you to save 
the current project file under a different name or to a 
different location on your system.

Import Impedance Data…
Opens a file dialog to select a .txt (or .zma) file containing data to be imported to the Workbench. Within the .txt file 
each data point must be on a single line in the format: “Frequency Impedance Phase” with the frequency, impedance 
and phase data separated by a tab or spaces. When the file is opened the data is imported to the DATS LA 
Workbench, interpolated via a powerful cubic spline routine and then plotted on the screen. Note that imported phase 
data must be in degrees. At least two data points are required. Data below 1 Hz will be ignored.  

Export Impedance Data…
Exports the response on the workbench to a .txt (or .zma) file for use with other applications. Each frequency and its 
impedance magnitude and phase are listed on a single line separated by tabs. The full frequency range, from 1 Hz up 
to F(s)/2, is exported. Note that exported phase data is in degrees. A text header is included which contains details on 
the extracted driver parameters. Data can also be exported in a format similar to data exported from CLIO. This allows 
importing driver parameters into various loudspeaker simulation software.

Open WinSpeakerz Driver File…
This opens a file dialog which allows you to select a WinSpeakerz individual driver file (.dvr) to open to the DATS 
LA Workbench. This is useful for exchanging data with WinSpeakerz (loudspeaker simulation software available 
separately from True Audio). Driver files contain only the Driver Editor data, no impedance plot data is contained in 
these files.
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Save WinSpeakerz Driver File …
Brings up a “save file” dialog which allows you to save the data and notes currently on the Workbench to a 
WinSpeakerz individual driver (.dvr) file. Driver files are saved with the .dvr filename extension. You can use individual 
driver files to exchange data with WinSpeakerz (available separately from True Audio). 

Print… (Ctrl+P)

Print Preview
Shows an on-screen preview of what the printed page will look like.

Print Setup…
This command displays the printer setup dialog to allow you to select the printer, paper and page orientation. Printing 
in portrait orientation provides space for the most printed notes, while printing in landscape orientation provides a 
larger printed plot with less space for notes.

Recent Files...
A list of recently used files is displayed for easy access.

Exit (Ctrl+Q)
Exits the application. The keyboard shortcut makes this action very convenient.
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Edit Menu
The commands under the Edit menu are as follows:

Undo (Ctrl+Z)
Undo is not implemented.

Cut (Ctrl+X)
Cut is implemented for various text fields. Text is cut and 
placed on the clipboard for pasting to another location if 
desired.

Copy (Ctrl+C)
Copy is implemented for various text fields. Copied text is 
placed on the clipboard for pasting to another location.

Paste (Ctrl+V)
Paste is implemented for various text fields. Use this 
command to paste text that has been placed on the 
clipboard.

Open the Driver Editor... (Ctrl+D)
Opens the Driver Editor for access to a fully detailed set of driver data. Besides the measured driver parameters 
there are fields for you to enter as much additional data as you wish. Each of the 20 memories in a project file holds 
its own complete set of driver data. When you save a driver file the complete set of data is saved to a .dvr file which 
can be opened by the popular loudspeaker design program WinSpeakerz. Similarly, individual driver files saved by 
WinSpeakerz can be opened in DATS LA.
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Preferences...
This command opens the Preferences Dialog (shown below) where you can change various printing, measurement 
and display settings.

Plots can be switched between fine and bold lines separately for display and printing. You can select metric units sep-
arately for Volumes and other units. 

Auto Ranging is normally on but can be switched off for those occasions where you need a different fixed scale for 
repeat measurements. An initial “connect the driver” dialog can be enabled for production testing. 

The driver’s voice coil inductance, L(e) is measured at both 1 kHz and 10 kHz. A preference can be set to display L(e) 
at either 1 kHz or 10 kHz. L(e) at 1 kHz is recommended for general use and this is the frequency most often used by 
general purpose inductance meters. Note that it is to be expected that L(e) measured at 10 kHz will be lower than L(e) 
at 1 kHz due to the permeability of the steel pole piece falling with increasing frequency. 

The impedance scale can be set for either linear or logarithmic plotting. 

The default number of significant digits that will be displayed is set to 4 by default but the user can set it to 3, 4 or 5 
digits. This setting is retained between sessions.
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Audio Device Selection...
This command refreshes the audio device information and then opens the Audio Device Selection dialog (shown 
below) where you can select an alternate device if necessary. If the DATS LA hardware is connected to the PC before 
the DATS LA software is launched then the software will automatically detect and select the DATS LA hardware. If 
the DATS LA hardware was connected after the software was launched then you may need to open the Audio Device 
Selection and select the DATS LA hardware as seen below.

Restore Default Settings...
This command restores all DATS LA settings and calibrations to their default state. If the software should become mis 
calibrated use this command to restore the initial calibration. Follow up by performing the test leads calibration and 1k 
Ohm calibration procedures. The user’s personal information, name, address, etc. is preserved through this operation.
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View Menu
The commands under the View menu are as follows: 

Toolbar 

Select the Toolbar command to alternately hide or 
show the toolbar.  

Status Bar 

Select the Status Bar command to alternately 
hide or show the status bar at the bottom of the 
main page. The Status Bar displays information 
for menu items and buttons. The Status Bar also 
indicates which memory is currently displayed. 

Show Phase Response 

The Phase Response has three different display 
modes: Off, On (located center screen) and On 
(located at top half). The display rotates through 
these three states as the menu (or toolbar) 
command is selected. The phase range is always 
+180 degrees to -180 degrees but the scale 
division varies with the selected impedance 
range (in order to use the same grid lines as 
impedance).  

Grid in Front 

Displays the grid in front of data on the main screen in order to facilitate reading precise signal levels. 
Normally the grid is displayed behind the data. 

Background Color 

Selects the background color for the main screen. The trace and grid colors also change with each 
background color. Choices are: Black, White, Light Gray and Dark Gray. 

Save to Memory 

These commands cause the plot on the Workbench to be saved to the selected 
Memory along with all the driver parameters. From the keyboard, use Alt+1, Alt+2 etc. through Alt+0 
to save to memories 1 through 10. Use Alt+Shift+1, 2 etc. through 0 to save to memories 11 through 
20. For example, to save the current response to Memory 5 you would press and hold the Alt key and 
then press the 5 key. 

Note: The most recently measured impedance plot is said to reside on the DATS LA 
“Workbench.” This measurement is overwritten each time the analyzer is run. The Workbench is 
also overwritten when a memory is recalled or when data is imported. Once you have measured 
data you want to keep (even temporarily) save it to one of the 20 memories before proceeding 
with another measurement. All data in the 20 memories is saved with the DATS LA project file. 
Multiple memories can be overlaid to allow for easy comparison of various measurements. Use 
the memory buttons in the Toolbar to show or hide various memories. After a memory has been 
recalled it can then be saved to a different memory. After a memory is recalled it is available to be 
exported to a .txt file. 
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Show/Hide Memory 

These commands alternately show and hide the selected memory: 

•  From the keyboard, use Ctrl+1, Ctrl+2 etc. through Ctrl+0 to show or hide memories 1 
through 10 

•  Use Ctrl+Shift+1, 2 etc. through Ctrl+Shift+0 to show or hide memories 11 through 20 

For example, to toggle the display of the response in Memory 5 you would press and hold the Ctrl key and then 
press the 5 key. Use Ctrl+W to toggle the display of the Workbench response. In addition to the menu and keyboard 
commands, you can also toggle each memory on or off at the Memory Toolbar. 

Clear Memory 

These commands erase the contents of the specified memory. 

• From the keyboard, use Ctrl+Alt+1, Ctrl+Alt+2 etc. through Ctrl+Alt+0 to clear the contents 
of memories 1 through 10  

• Use Ctrl+Alt+Shift+1, 2 etc. through Ctrl+Alt+Shift+0 to clear the contents of memories 11 
through 20 

For example, to erase the response in Memory 5 you would press and hold the Ctrl and Alt keys and then press the 5 
key. Should you need to clear all of the memories it is usually easier to just create a new project file by selecting “New” 
under the “File” menu. 

Hide All Memories (Ctrl+E) 

This command turns off the display of all memories without affecting the contents of the memories. 
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Frequently Asked Questions about DATS LA

Does DATS LA measure a speaker’s BL product?
Yes, DATS LA measures many parameters that are not displayed on the main screen. To view these additional param-
eters, open the Driver Editor window from the Edit menu or use the keyboard shortcut Ctrl+D. 

The title block is empty on my printed reports. How do I enter my info?
Navigate to Help > User Information to open the User Information dialog. The details you enter here will appear in 
the title block of your printed reports. 

How accurate is DATS LA?
Because the speaker parameters are extracted from the impedance data they can only be as accurate as the im-
pedance measurement itself. When calibrated with the supplied calibration resistor (1000 Ohms, ±0.1 %) DATS LA 
provides measurements between 1 and 1000 Ohms that are typically accurate to better than ±0.5 %.

Can DATS LA measure a regular commercial speaker system from the terminals?
Yes. DATS LA can measure the impedance of any electronic device provided it is “floating” and not connected to other 
devices. A wide range of electronic devices can often be characterized as healthy or faulty just by comparing the mea-
sured impedance to a known good device. 

Can I reduce the test signal level for testing micro speakers?
Yes. Switch to the Oscilloscope mode and look for the Z Sweep amplitude box at the bottom left. By default, the 
sweep level is +10 dBu but you can reduce the level to as low as -10 dBu.
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DATS LA Software Calibration
In addition to the precision components (± 
0.5% resistors) used throughout the hardware, 
DATS LA employs three different calibration 
procedures to ensure that measurements are 
accurate and precise. When the unit is first 
used with a PC, it is necessary to perform all 
three calibration procedures. DATS LA saves 
the calibration settings to a small .ini file on 
the PC, so it is not necessary to calibrate the 
system each time you use it.  
 
The calibration procedures are found under 
the “Impedance Analyzer” menu. 
 
Perform the calibrations in the following order: 
1. Null Calibration 
2. Impedance Calibration 
3. Test Leads Calibration 
 
It is a good idea to begin each complete 
calibration by restoring the default settings 
(see the Edit menu). It is best if the unit has 
been powered on for at least 15 minutes 
before calibrations are performed. 
 
The first procedure is the null calibration 
procedure. it is very important that you 
disconnect the test leads or make sure that the test leads are not connected to any equipment before you begin the 
null calibration procedure. This is because the null calibration procedure uses a very high-level signal which could 
damage any attached speaker or other equipment. After the Null Calibration window opens click the OK button and 
the procedure will begin. On the screen you will see the oscilloscope waveform as the procedure hunts for the null. It 
starts with a coarse search and then switches to a fine search. to achieve a very precise null calibration. The point of 
this procedure is to match the two input levels very precisely to assure that high impedance calibration is the best it 
can be. 
 
The second calibration step is the impedance calibration. When you perform this calibration the impedance calibration 
dialog opens with 0.1 k Ohms (100 Ohms) set as the calibration resistor value. Connect the test leads across the 
calibration resistor terminals at the DAS LA front panel and click OK. The system performs a sweep test and calibrates 
the system impedance magnitude at 100 Ohms.  
 
The third calibration procedure is the test leads calibration. The dialog box opens and you are asked to short the test 
leads. Click OK and the system performs a sweep and calibrates the shorted test leads. Following calibration, the test 
leads resistance displayed in the lower right area of the screen should be nonzero. 
 
In Summary: It is necessary to perform all three calibrations when the unit is first set up on a new (or different) PC. 
After the initial calibration you should perform at least the test leads calibration at the start of each test session you 
may also want to measure the 100 Ohm resistor value as you start a work session. The Impedance and Test Leads 
calibrations are performed at a signal level of 0 dBu with the user’s sweep level restored after each procedure is 
complete.
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Using DATS LA to Design a Zobel Network
Zobel networks are used to control the impedance of a loudspeaker driver in the upper frequency range where voice 
coil inductance normally causes the impedance to rise with increasing frequency. Zobel networks are used to help 
crossovers do a better job of keeping the highs from passing to the woofer.  

A Zobel consists of a resistor and capacitor connected in series and attached between the terminals of the driver. 
The resistor is normally selected to match the nominal impedance of the system. The capacitor value can then be 
calculated or, in this case, determined empirically. Because DATS LA is able to perform impedance sweeps in just 
a few seconds it can be used for any type of repetitive adjust and measure process...such as designing a Zobel 
network to neutralize the inductance of a driver. Yes, you can calculate the component values for a Zobel network 
but sometimes it is easier to just clip a resistor/capacitor network across the driver and see what you get for the 
impedance.

Next is the impedance response of a small woofer with no other components connected. Notice the rising impedance 
above 500 Hz. In this exercise we will design a Zobel network to connect across the woofer. The Zobel network will 
compensate for the woofer’s rising impedance and restore the high frequency impedance to be close to the nominal 
6-8 Ohm value in the frequency range above 500 Hz. Applying a Zobel network makes a woofer’s impedance more 
like that of a resistor in the upper frequency range. This allows a passive crossover to more closely achieve its 
intended high frequency cutoff. Without a Zobel, woofers often pass more high frequency content than was intended.
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With a DC resistance of 5.5 Ohms this would most likely be considered to be an 8 Ohm driver. So, let’s set the resistor 
value to about 8 Ohms. Looking in my parts bin I see the closest values on hand are 5 and 10 Ohms. Let’s use 10 
Ohms so that we tend to undercompensate. We’ll select the capacitor value by starting too low and stepping up the 
capacitor until the impedance response looks about as flat as we can get it in the upper frequency range. Let’s start 
with around 1 uF for the capacitor and see what we get for a new impedance response. The next screen shows the 
new impedance response in purple with the original (uncompensated) response in blue. Notice that the impedance 
has only been reduced above 5 kHz. This is because our capacitor value is too low. Let’s increase the capacitor and 
see what happens.
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The following screen shows the impedance with the capacitor increased to 2 uF (blue trace). The original 
(uncompensated) impedance is shown in green. The 2 uF capacitor has flattened out the impedance so that it rises 
only slightly above 8 Ohms. Since it is easy to do let’s continue to increase the capacitor value and see if we can get 
a further improvement. Ideally, we would like the impedance to be as flat as possible...at least above the resonance 
peak. 
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The screen below shows the effect of increasing the capacitor to 3 uF (blue trace). The increase from 2 to 3 uF gave 
even further improvement as the impedance above resonance is now quite flat. Just to see what happens, let’s 
increase the capacitor further to 5 uF.
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Next, we see the effect of increasing the capacitor to 5 uF in the lowest (blue) trace. It seems we have gone too far 
with the increase to 5 uF. The impedance in the 2 to 3 kHz range has been reduced to the DC resistance value and is 
now rising above the previous measurement with the 3 uF capacitor. This rise may be due to an interaction with the 
voice coil inductance. It looks like the 3 uF capacitor will be the best overall choice to tame the driver’s high frequency 
impedance.  

The point of the exercise was to demonstrate how an inductance compensating network, or Zobel network, could 
be designed experimentally by “trial and error”. Even if you choose to calculate the values for the Zobel network 
you still might want to verify the resulting impedance response of the driver with the Zobel connected. In general, 
you could take the same approach to verify other networks such as the resonance compensation network (R-L-C) 
sometimes used to neutralize the impedance peak of a tweeter. As an impedance measurement system, the additional 
applications for DATS LA are limited only by the user’s imagination.
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Using DATS LA to Diagnose Loudspeaker Fault Conditions
When carefully applied DATS LA can be used to spot common problems with a speaker system. For example, the 
screen below shows two impedance measurements of the same two-way speaker system. The green (lower) plot 
shows the normal impedance response of this system. The purple (upper) plot shows the system with the tweeter 
in an open circuit fault condition. The missing tweeter load causes the impedance response to rise above 2 kHz 
suggesting that the tweeter has faulted to an “open circuit”. If only the faulty speaker is available for testing it may be 
less apparent that there is a problem. But if a suspect speaker is compared to a good speaker the fault condition is 
usually easy to see.
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In the screen below you see the same system as above but this time with a shorted tweeter. The green plot in the 
figure below shows the normal impedance response of this system. The orange (lower) plot shows the system with a 
shorted tweeter. The system with the shorted tweeter appears to have a suspiciously low impedance above 4 kHz or 
so and when compared to the normal response (green) it is easy to see there is a problem.
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Now let’s examine similar fault conditions for the woofer. The screen below shows the same 2-way system as above 
with the green plot representing the normal system and the orange plot showing the system in a fault mode with an 
open circuit woofer. The system is seen to be unloaded (high impedance) over most of the woofer’s frequency range.
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Finally, here is a screen shot showing the same system with the woofer in a short circuit fault condition (lower blue 
trace). As we see in these examples often a system fault is most easily detected by comparing the suspect system to 
a known good system.
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Using DATS LA to Evaluate a Vented Box Loudspeaker
A vented box type of loudspeaker system can be characterized by its equivalent closed box Q(tc) and the vented en-
closure’s Helmholtz tuning frequency, F(b). You can use DATS LA to measure both of these parameters for any vented 
box loudspeaker system. As a fourth order high-pass filter, the frequency response of a vented box is more complex 
than that of a (2nd order) closed box. The characteristics of the fourth order high-pass response depend on both the 
equivalent closed box response and the vent tuning frequency.

The impedance response of a typical vented box speaker is characterized by two impedance peaks in the low fre-
quency region. The enclosure’s tuning frequency is indicated by the frequency where the impedance is at a minimum 
between the two resonance peaks.

Before starting make sure the DATS LA unit has been calibrated.

Measure the system impedance as follows:

•	 Launch the DATS LA software and make sure the volume is at maximum. 

•	 Make sure that the speaker system is not connected to any other equipment and then connect the test leads 
of the DATS LA unit to the speaker under test. 

•	 Temporarily block the speaker’s vent using an airtight plug to convert the speaker to the equivalent closed box 
system. 

•	 Click the “Measure Free Air Parameters” button at the left side of the DATS LA screen. 

•	 You should hear the sweep from the speaker, the impedance is plotted and the parameters are displayed.

•	 The system’s equivalent closed box resonance frequency, F(sc) is displayed in the F(s) data field.

•	 The system’s equivalent closed box total Q, Q(tc) is displayed in the Q(ts) field. 

•	 Save the equivalent closed box data to a memory for future reference.

•	 Unplug the vent and click the “Measure Free Air Parameters” button again.

•	 You should hear the sweep from the speaker, the impedance is plotted.

•	 Identify the two resonance peaks in the low frequency range.

•	 Read the system’s box tuning frequency, F(b) as the frequency at the minimum between the two peaks.

•	 The DC resistance of the system is displayed in the R(e) field. Ignore all other parameters.

•	 Repeat the measurement to confirm the result. Repeated measurements should be in good agreement.
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Here is a typical result when measuring a single full range driver in a vented box type enclosure:



DATS LA 75 DAYTONAUDIO

In order to read the vent tuning frequency, F(b), more precisely we can adjust the frequency display limits to zoom in 
on the frequency range containing the two impedance peaks as shown below:

At this screen we can determine that F(b), the tuning frequency of the vented box, is approximately 40 Hz by locating 
the impedance minimum between the two peaks and reading the frequency where the minimum occurs. By setting the 
upper frequency limit at 200 Hz we get a closely zoomed view that makes it easier to read the tuning frequency. 
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Using DATS LA to Measure a Tweeter’s Parameters
A typical sealed back moving coil tweeter operates as a very small closed box system and therefore can be character-
ized by its closed box resonance and Q, F(sc) and Q(tc). You can use DATS LA to measure these two parameters for 
tweeters as well as woofers and midranges. The frequency response of a tweeter is the same as that of a purely elec-
trical second order high-pass filter with the same electrical resonance frequency and Q as the tweeter’s electro-acous-
tic resonance and Q. While the resonance frequency determines the low frequency bandwidth of the tweeter the Q(tc) 
determines the shape of the response in the corner region with Q = .707 corresponding to a maximally flat Butterworth 
response. 

The impedance response of a tweeter operating as a closed box loudspeaker has a single well defined peak at the 
tweeter’s primary resonance frequency at the low end of the tweeter’s operating range. 

Before starting make sure the DATS LA unit has been calibrated.

Measure the tweeter’s impedance as follows:

•	 Launch the DATS LA software and make sure the volume is at maximum. 

•	 Under the Edit menu select Preferences and set the L(e) Measurement Frequency to 10 kHz.

•	 Make sure that the tweeter is not connected to any other equipment and then connect the test leads of the 
DATS LA unit to the tweeter under test. 

•	 Click the “Measure Free Air Parameters” button at the left side of the DATS LA screen. 

•	 You should hear the sweep from the tweeter: the impedance is plotted and the parameters are displayed.

•	 The tweeter’s equivalent closed box resonance frequency, F(sc), is displayed in the F(s) data field.

•	 The tweeter’s equivalent closed box total Q, Q(tc), is displayed in the Q(ts) field. 

•	 Save the equivalent closed box data to a memory for future reference.

•	 The DC resistance of the tweeter is displayed in the R(e) field. Ignore all other parameters.

•	 Repeat the measurement to confirm the result. Repeated measurements should be in good agreement.
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Here is a typical result when measuring a tweeter:

We can read the tweeter’s resonance frequency, F(s), (or, more strictly F(sc), since it is a closed box system), directly 
from the impedance plot or note the value at the Measured Parameters F(s) field. Just as with a closed box, the sys-
tem’s Q(tc) is read from the Q(ts) field. The electrical and mechanical Q’s are interpreted similarly. The tweeter above 
has a resonance of 1.848 kHz and Q(tc) of .5067.
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Using DATS LA to Evaluate a Complete Speaker System
You can use DATS LA to measure the impedance of complete multi-way loudspeaker systems. Based on this 
impedance curve we can tell a number of things about the system such as whether the woofer uses a closed or 
vented enclosure. While a single peak in the low frequency range suggests a closed box, a single peak would also be 
seen for a driver operating as a dipole on a large baffle. Twin resonance peaks typically indicate a vented enclosure. 
The enclosure tuning frequency is the frequency between the two peaks where the impedance is at a minimum.

Before starting make sure the DATS LA unit has been calibrated.

Measure the speaker system impedance as follows:

•	 Launch the DATS LA software and make sure the volume is at maximum. 

•	 Make sure that the speaker system is not connected to any other equipment and then connect the test leads 
of the DATS LA unit to the speaker under test. 

•	 Click the “Measure Free Air Parameters” button at the left side of the DATS LA screen. 

•	 You should hear the sweep from the speaker, the impedance is plotted and the parameters are displayed.

•	 Save the system’s impedance response to a memory for future reference.

•	 The DC resistance of the system is displayed in the R(e) field. Ignore all other parameters.

•	 Repeat the measurement to confirm the result. Repeated measurements should be in good agreement.
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The figure below shows a typical result when measuring a complete 2-way speaker system. We can see that this 
system employs a vented woofer system with the vented enclosure tuned to about 40 Hz. Even with a minimum 
impedance of just over 6 Ohms this would often be considered to be a nominal 8 Ohm loudspeaker system.
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Using DATS LA to Measure a Resistor
Before starting make sure the DATS LA unit has been calibrated.

Measure the value of a resistor as follows:

•	 Launch the DATS LA software and make sure the volume is set at maximum. 

•	 Make sure that the resistor is not connected to any other equipment and then connect the test leads of the 
DATS LA unit to the resistor under test. 

•	 Click the button labeled “R” at the bottom left of the DATS LA screen. The following dialog box appears:

•	 Press the “Test” button to perform the measurement. The sweep is silent, then the impedance is plotted and 
the value displayed.

•	 Repeat the measurement to confirm the result if you wish. Repeat measurements should be in excellent 
agreement.

Here is a typical result after measuring a precision (0.1%) 10 Ohm resistor:

An ideal resistor would have a perfectly flat impedance response at exactly the rated value of the resistor. This is 
not unusual for a resistor because real resistors typically do behave largely as ideal resistors. The impedance phase 
response is usually essentially flat at 0 degrees for a resistor but a slight rise at the high frequency limit can indicate 
that the resistor also has some inductance. Here the measured value of 10.01 Ohms is in good agreement with the 
resistor’s specified value of 10 Ohms +/- 0.1%. 

At full playback volume the “noise” on a resistor measurement is usually no more than one or two pixels. Higher noise 
levels can indicate that the test signal level was too low and should be increased. 
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Using DATS LA to Measure an Inductor
Before starting make sure the DATS LA unit has been calibrated.

Measure the value of an inductor as follows:

•	 Launch the DATS LA software. 

•	 Make sure that the inductor is not connected to any other equipment and then connect the test leads of the 
DATS LA unit to the inductor under test. 

•	 Click the button labeled “L” at the bottom left of the DATS LA screen. The following dialog box appears:

•	 Press the “Test” button to perform the measurement. The impedance is plotted and the inductor value and 
resistance are displayed.

•	 Repeat the measurement to confirm the result if you wish. Repeat measurements should be in excellent agreement.

Here is a typical result after measuring a 1.0 mH inductor:

An ideal inductor would have an impedance of zero Ohms at the lowest frequencies and then the impedance would 
rise with increasing frequency. The phase response of the inductance depends on the exact circuit in which the inductor 
finds itself. At very low frequencies (1 Hz) the impedance measurement reveals the DC resistance of the inductor. The 
impedance of an inductor is usually near zero (or minimum) at low frequencies and rises at high frequencies as the 
inductive reactance increases. The phase response is near zero degrees at low frequencies and increases to 90 degrees 
at high frequencies as expected for the simple (R-L) test circuit formed by the test system. The measured value of 0.997 
mH is in good agreement with the inductor’s nominal 1.0 mH rating. At 0.246 Ohms the inductor’s DC resistance is nicely 
low as required for use in a passive crossover. Note that DATS LA measures inductance at numerous audio frequencies 
and uses the most accurate data to determine an average value for the measurement.  
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Using DATS LA to Measure a Capacitor
Enhanced capacitor measurement: The capacitor measurement module does more than measure a capacitor’s 
value; it also measures the capacitor’s equivalent series resistance (ESR), dissipation factor (DF), quality factor (Q), 
and loss angle (δ) at three different frequencies: 120 Hz, 1k Hz, and 10k Hz.

Before starting make sure the DATS LA unit has been calibrated.

Measure the value of a capacitor as follows:

•	 Launch the DATS LA software.

•	 Make sure that the capacitor is not connected to any other equipment and then connect the test leads of the 
DATS LA unit to the capacitor under test. 

•	 Click the button labeled “C” at the bottom left of the DATS LA screen. The following dialog box appears:

•	 Press the “Test” button to perform the measurement. The sweep is silent, then the impedance is plotted and 
the capacitor value is displayed.

•	 Repeat the measurement to confirm the result if you wish. Repeated measurements should be in excellent 
agreement.
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Here is a typical result after measuring a 1 uF, 1% film type capacitor:

An ideal capacitor would have an impedance approaching zero Ohms at the highest frequencies and then the imped-
ance would rise with decreasing frequency. Using the log impedance scale a capacitor’s impedance appears as a 
straight line which falls with increasing frequency. The impedance of a capacitor approaches zero at high frequencies 
and increases at lower frequencies. The phase response is not relevant for capacitor measurements. Note that the 
measured value of 1.0026 uF is in very good agreement with the capacitor’s specified 1 uF (+/- 1%) value. Note that 
DATS LA measures capacitance at numerous frequencies and uses only the most accurate data to determine a value 
for the measurement.

In addition to measuring the capacitance value of the capacitor DATS LA also measures the equivalent series re-
sistance (ESR), dissipation factor (DF), quality factor (Q), and loss angle (delta) of a capacitor. High quality, low DF 
(<1%) capacitors as shown here will run cool when operated at high power levels in loudspeaker crossovers. The DF 
at 1 kHz is the one of primary interest to loudspeaker crossover designers. The values for 120 Hz and 10 kHz are 
provided more for designers of electronic power supplies.
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